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1. About DEIF Smart Connect

DEIF - Smart Connect

DEIF Smart Connect is a PC based utility software for Windows operating system, used to configure DEIF's SGC controllers.

The utility software allows controllers from the SGC range to be connected to a laptop/computer via USB, which makes it
easy to configure each individual input and output, timers, generator, governor and engine speed monitoring parameters.
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2. Installation instructions

2.1 System requirements

e Operating System: Windows 8 and 10 with Microsoft .Net 4.0 framework.
« Communication: USB 2.0 Type A to Type B cable is required for communication with the controller.

2.2 Installing DEIF Smart Connect

Procedure for installation of DEIF Smart Connect:

Go to DEIFs software download page deif.com/software.

Select DEIF Smart Connect.

Follow the download instructions.

Locate the DEIF-Smart Connect-Setup.zip on your system and unzip the archive.
Double-click the installation file DEIF-Smart Connect-Setup.exe.

The Welcome screen appears, select Next.

In the Install Location screen, browse to your preferred destination folder, then select Install.

® N O LN

In the Completion screen, select Finish to complete the installation.

2.3 Installing the USB driver
When an SGC controller is connected to a PC or laptop via USB, the necessary USB driver is automatically installed.

In some cases it can be necessary to install the USB driver manually:
1. Connect the controller to a PC with a USB cable.

2. Set the controller in the Programming mode (press the buttons Stop/Config and Down simultaneously for at
least three seconds.

3. The controller shows the Programming mode screen.

Programming Mode

o]
ooo Q

With the controller in Programming mode, go to Device Manager -» Ports (COM & LPT) -» SGCSMPL on the PC.

Right click on SGCSMPL and select Update Driver Software.

Select Browse my computer for driver software.

For 64-bit Windows system, choose a driver path such as C:\Program Files(x86) \DEIF, then click Next.

When the USB driver is installed, a confirmation screen appears Windows has successfully updated your driver software.

© ® N o oA

Click on Close to finish the installation of the USB driver.

10. To leave the Programming mode, press the Up and Down buttons simultaneously for at least three seconds.
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3. Using DEIF Smart Connect

3.1 Connect to the controller

To connect to a controller:

1. Open the DEIF Smart Connect on your PC.

2. Connect the PC to the controller with a USB cable.

3. Set the controller in the Programming mode (see 2.3 Installing the USB driver).

A connection status message is shown at the bottom left corner of the Smart Connect screen.

@ DEIF - Smart Connect

File Tools Help
IS Hd4 B SGC410 (R2.0)
Module Digital Inputs Analog Inputs Outputs Timers Generator Mains Engine Maintenance

- 0 X

SGC410 (R2.0) Device is connected |

It is possible to open, create and modify configurations without an active connection to the controller. But read/write to the
controller requires an active connection.

3.2  Starting with DEIF Smart Connect

Run DEIF Smart Connect. On the start-up screen you can choose between Create new configuration and Open existing
configuration.

DEIF - Smart Connect

Create new configuration Open existing configuration
SGC 1X Series
SGC 4X Series

Browse

Version:1.1.1.28

4189341232D EN Page 5 of 15



Create new configuration
Click on the controller type (for example, SGC 1X Series) you wish to create a configuration for, then select the controller/
revision.

DEIF - Smart Connect

Create new configuration Open existing configuration
SGC 1X Series

SGC 4X Series | SGCAXX  » SGC410 v
SGC420 »
SGCA21  » | sGC421 (R1.0)
T sGC421 (R2.0)
| 56C421 (R3.0)

Version:1.1.1.28

Open existing configuration
Previously created configurations can be saved on the PC in .smc format. Click on Browse to search for a saved smc-file.

Incompatible device
The selected controller can be incompatible if:
« The controller selected in DEIF Smart Connect is different from the connected controller.

e The controller revision and DEIF Smart Connect revision mismatches (for example, SGC R2.0 and DEIF Smart Connect
R1.0).

If a controller is incompatible, DEIF Smart Connect gives a pop-up message.

DEIF - Smart Connect “

The selected product is not compatible with the device detected.
Do you want to continue?

e Select Yes, then connect the correct controller or correct the revision mismatch
e Select No to close DEIF Smart Connect.

3.3 File menu options

A configuration is a set of parameter values, which determine the behaviour of the controller. The options to handle the
configured parameters are all grouped under File.

] New
5 Open Ctrl+0
= Save Ctri+S
kg Saveas Ctri+Shift+S
4 Print Ctri+P
@] Exit

« New: To create a new configuration file, click on File - New.

« Open: To open a previously saved configuration file from disk, click on File - Open.

« Save: To save the current set of parameter values as a configuration, click on File - Save.
« Save as: To change the name/location of a saved file, click on File - Save as.

e Print: To print out a table with the configured parameters, click on File - Print.

o Exit: To close DEIF Smart Connect, click on File - Exit.
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Shortcut icons for New, Open, Save, Print, Read and Write DEHE|EW is shown on the screen. They can be used
for easy access to these functions.

4189341232D EN Page 7 of 15



4. The Tools menu

4. Tools menu options

With DEIF Smart Connect a set of actions can be made in addition to editing and saving the configurations. These actions
are found in Tools menu, and are enabled when an active connection with a controller is detected.

| & Write config to device
| ¥ Read config from device
|es  Read event log from device

1(© Set date and time on device

1 Show device info
@ Update Factory Profiles

« Write config to device: To write the configuration to the controller, click on Tools - Write config to device.
* Read config to device: To read the configuration from the controller, click on Tools - Read config to device.

+ Read event log from device: To display and read the event logs from the controller, click on Tools - Read event log from
device.

+ Set date and time on device: To update date and time in the controller to the system's date and time, click on Tools -
Set date and time on device.

« Show device info: To details about the controller, the software and more, click on Tools - Show device info.
« Update factory profiles: To update the controller's factory profile, click on Tools - Update factory profile.

4.2  Write config to device

When selecting Write config to device, a pop-up window is shown with the existing parameter values.

@ Configuration Summary . X
Menu SubMenu Parameter Walug £
General Profile Mame profile 1
Power On Mode Manual
. Power On Lamp Test . Disable
. Deep Sleep Mode . Disable
Load Histogram Dizable
Auto-Clear Watning Alam Disable
. Language . English
Display . Conlrast . 50
Power Save Mode Dizable
Communication Communication Made MNone
' Modbus Slave ID 2
. Modbus Baudrate 9600
. Parity Norne
Site Battery Monitoring Battery Monitoring Enable
. Low Valtage Thieshold 60
. Battery Monitating Delay . 20
. Genset Run Duration . 270
Cyclic Mode Cychc Mode Disable
Genset Off Tine 15 ¥
Edit Config | ‘ Save Config To File | ‘ Write To Device

« Click on Edit Config to change any parameter value.
« Click on Save Config To File to save the changes.
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« When all changes have been made, click on Write To Device to send the new parameter values to the controller.

When the writing process is completed, a confirmation window is shown.

DEIF - Smart Connect

Configuration is written on the device.

4.3 Read config from device

When selecting Read config from device, the existing controller configuration is imported to DEIF Smart Connect.

When the reading process is completed, a confirmation window is shown.

DEIF - Smart Connect

Successfully read the configuration from the device.

4.4  Read event log from device

Select Read event log from device to display the event log from the connected controller.

The event log shows the last 100 events (for example, engine start, engine stop, actuator failure, and more), including
informations like engine run hours, date and time .

€D Event Log -
B [cmomoien  [Su6 [Rmtesl [Emibem [Dobee [Be (BB
A N Matification 24-03-2020 08:05:20 0 brs & min 0RPM 0.1 K MA,
2 Aue_M Maotification 24-03-2020 07:31:03 0 hrs 8 min 0RPM 0.1 KW M
3 f L Matification 24-03-2020 07:31:03 0 hrs 8 min 0RPM 0.1 Kw M
4 e K Motification 24-03-2020 07:31:03 0 hrs 8 min ORPM 0,1 Ew M&
5 A Motification 24-03-2020 07:31:03 0 hrs 8 min ORPM 0.1 KW MA
B A M Motification 24-03-2020 07:30:45 0 hrs 8 min ORPM 0.1 KW MNA
7 A L Matification 24-03-2020 07:30:45 0 hrs & min 0RPM 0.1 KW MA
8 A K Maotification 24-03-2020 07:30:45 0 hrs 8 min 0RPM 0.1 Kw M
3 A Motification 24-03-2020 07:30:45 0 hrs 8 min 0RPM 0.1 Kw Ma
10 A N Motification 23-03-2020 15:30:48 0 hrs 8 min 0RPM 0Kw M
1 A N Motification 23-03-202015:30:34 0 hrs 8 min DFRPM oKW A
12 A N Matification 23-03-2020 15:30:26 0 hrs & min 0RPM 0Kw MA
13 A M Matification 23-03-2020 15:30:04 0 hrs & min 0RPM 0Kw M
14 A N Matification 23-03-2020 15:29:30 0 hrs 8 min 0RPM 0 KW M
15 A N Motification 23-03-202015:28:35 0 hrs 8 min 0RPM 0 KW M
16 Aux N Motification 23-03-2020 15:16:45 0 hrs 8 min 0RPM 0 Kw M
17 By P Motification 23-03-2020 07:33:37 0 krs 8 min OFRPM 0,1 KW M&
Save As POF
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To save the event log in PDF format, click on Save As PDF.

4.5 Set date and time on device

Select Set date and time on device to synchronise the controller's date and time with your PC. Make sure that the date and
time of your computer system are correct, before you start to synchronise.

DEIF - Smart Config

Would you like to update device date and time?
Computer’s current date and time will be used as source

[ % ]

When the synchronisation process is completed, a confirmation window is shown.

DEIF - Smart Config

Updated the device date and time.

4.6 Show device info

Select Show device info to see information about the product, software and other details in the controller.

The controller must be in Programming Mode to be able to show device info. Press the buttons Stop/Config and Up
simultaneously for at least three seconds to set the controller in Programming mode (see 2.3 Installing the USB driver).

The device info is shown in a pop-up window.

Firmware Checksum{Hex)

@) Device Information - X
Description Value
Prod d SGC421 (R2.00)
Serial No. | 00200000-CBEASIET-4E455111-40140014A
Bootloader PLM id ' SM10145 (R0.01)
Firrnware PLM id | SM10155 (R1.09)

| A8T72

Firmware Updated Date

Parameter Checksum(Hex)
Parameter Updated Date

Product Info Checksum(Hex)
Product Info Updated Date

Icons & Sting Package Flash status
Language Package Flash status

| 16:03-2020 08:42:23

0508

| 24-03-2020 09:44:25

Ci1CA

| 16-03-2020 08:42:56

| No Icons &nd Stiings Flashed
| No Languages Flashed
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4.7  Update factory profiles

With Update factory profile you can update, configure or modify all profiles stored in a controller.

=7

Update Factory Profiles

Select the Files that you want to update at the respective profile number

Profile number | File Name
| 1 | FADEIF\ConfigurationFiles\SGC120\ | Browse | Clear |
| 2 ' FADEIF\ConfigurationFiles\SGC120\ | Browse | Clear |
| 3 | FADEIF\ConfigurationFiles\SGC120\ | Browse | Clear |
] | Corowss
s ] Browse
] | Corowes ][_oear ]
] | Corowes |[_oiear ]
‘ 8 H H Browse H Clear ‘
5 | Corowes |[_ctemr |
| 10 I | Browse = Clear |

Update Factory Profiles
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5. The Help menu

5.1 Mode selection
When selecting Mode selection, a diagram over the controller modes and how to configure the modes is shown.

The Mode selection diagram is dependent on the chosen controller. This example, shows the diagram for SGC 121.

@D Controller Mode Selection — X

Auto Key Pressed

Manual Mode

A4

Auto Mode

Stop Key Pressed

passald buoT Aay umoq g dn

passald Buo Aayumoq g dos

i
<

Configuration
Mode

Programming

Mode

Mode Selection - SGC110/SGC120/SGC121

5.2  About

When selecting About, a pop-up window with information on the present version of DEIF Smart Connect is shown.

5 DEIF - Smart Connect X
Product: DEIF - Smart Connect
Version:1.1.1.231

Publish By: DEIF

Description: Smart Connect is used for configuring
DEIF's GCU products.
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6. Configurable parameters

Many controller parameters (for example, Digital Inputs, Outputs, Generator, Mains, Rotary Actuator, and more) can be

configured by the user to apply to a specific applicati

The parameters comes in three levels:

on.

& DEIF - Smart Connect
File Tools Help
DEEHS R

Module Digital Inputs Analog Inputs Outputs Timers Generator Mains Engine Maintenance

- [m] X

5GC120 (R3.0)

Digital InputA Dpigital Input B Digital Input € Digital Input D Digital Input E

[1] DIGITALINPUT A
Source Mot used

Name Auxiliary Input A
Polarity Close to Activate
Action None

Activation From Monitoring On
Activation Delay 1 <) sec

o
Lo

1. Parameter groups: Each
parameter group has its own
set of Level 1 parameters.

2. Level 1 parameters: Choose a
parameter for configuration.

o 3. Level 2 parameters: Configure
the parameter values.

SGC120 (R3.0) Device is connected

More information
See Configuration mode, Configurable parameters in the specific controller user manual for more information

about parameters and levels.

Example: Configure a parameter

The options in the Level 2 configuration screen changes with the parameter. This example shows the configuration options

for the parameter Module > Display:

CJ Display —

0

Contrast 50 % 9 |

Power Save Mode D~\

—————©

4189341232D EN

1. Level 2 parameter configuration window.

2. Increase/decrease parameter value with the arrows.
3. Increase/decrease parameter value with the slider.
4. Check box to enable/disable the parameter.
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/. Troubleshooting

The USB driver is not detected. Re-install the USB driver, see 2.3 Installing the USB driver.
@ ) ) Ensure that the controller is in Programming Mode.
Read ["and Write (*Zjicons are not shown. To enter Programming Mode, see 5.2 Mode selection.
] NEEHE EW Ensure that the right controller name and software version is
No options e -~ = are shown. selected in the start-up screen.
Message:
Error in reading the configuration from the device. Please try
again.
Disconnect the USB cable, then reconnect the cable.
Message:
Cannot communicate with the device. Try re-inserting the
USB.
Message:
The selected Product is not compatible with the device See 3.1 Starting with DEIF Smart Config.

detected. Do you wish to continue?
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8. Legal information

Warranty

WARNING
The controller is not to be opened by unauthorised personnel. If the controller is opened anyway, the warranty will
be lost.

Disclaimer

DEIF takes no responsibility for installation or operation of the generator set. If there is any doubt about how to install or
operate the engine/generator controlled by the SGC controller, the company responsible for the installation or the operation
of the set must be contacted.

DEIF A/S reserves the right to change any of the contents of this document without prior notice.

The English version of this document always contains the most recent and up-to-date information about the product. DEIF
does not take responsibility for the accuracy of translations, and translations might not be updated at the same time as the
English document. If there is a discrepancy, the English version prevails.

Copyright
© Copyright DEIF A/S 2020. All rights reserved.
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